
Using Excel to 
Troubleshoot EMIS Data



The Ohio Department of Education funds development of EMIS training materials 
as part of the EMIS Alliance grant. There is an expectation that ITCs will utilize these 
materials in training provided to your districts. That said, there are restrictions on 
use of the EMIS Alliance materials as follows: Materials developed as part of the 
EMIS Alliance program must be provided at no cost to your training participants. If 
you utilize the EMIS Alliance training materials – in whole or in part – you must not
charge participants a fee to attend the class where the materials are used. Likewise, 
you may not use the materials or any portion thereof in any event where a fee is 
charged to attend. Exceptions must be approved in writing by the Department of 
Education in advance of scheduling/promoting any event which may violate these 
restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for 
exception to the restrictions noted above, should be directed to Melissa Hennon 
[Melissa.Hennon@education.ohio.gov].
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Overview

• Basic, Intermediate, and Advanced Excel techniques can be 
used to analyze EMIS data from Student Information Systems 
(SISs), from the Data Collector, and on ODE EMIS reports

• This session will demonstrate Excel functions and practical 
applications that can be helpful in all phases of the EMIS 
data review process 
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Outline

• Enrollment Headcount Summary Report
• Best Practices

• Enrollment Headcount Detail Report
• PivotTable Ideas   

• FTE Detail Report
• PivotTable Example
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Enrollment Headcount 
Summary Report
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Preview/Submission/Review Files

6

• Depending on the collection status and location within the data 
collector, the files are called-
• Preview files 

• Submission files

• Review files

• Files contain data from your LEA only

• For open collections, the data in the report will be as current as the 
source data used, and the date it was collected and prepared

• For closed collections, the data will represent the last time the data was 
prepared



Files Containing Data from your SIS
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Each type of collection 
has a unique set of 
preview files, this is from
a student collection not 
SCR

Reviewing these 
files can aid in 
verifying your SIS 
data for accuracy 
and completeness

Remember, there’s 
not an error for 
everything that is 
incorrect or 
incomplete!



Enrollment Headcount Summary 
(Current Students)
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Start by opening the 
Enrollment Headcount
Summary Report 



Prepare the Report 

• Open Enrollment_Headcount_Summary_Report_(Current_Students)
• Wrap text header row

• Freeze top row

• Expand all columns

• Apply filters

• Better yet, run your macro!

• To learn how to record a macro, prior year EMIS Alliance Excel sessions 
can be found here 
• https://community.mcoecn.org/display/EM/EMIS+Alliance+Public+Space
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Enrollment Headcount Summary Report 
(Current Students)

• Prepare – don’t have to submit, just collect up-to-date data 
and prepare to get the updated numbers as of “today”

• Captures current students by both headcount and by percent 
of time

• Filtering can be done to narrow the summary data down into 
building and grade level data

10



Summary Data 
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Headcount and Total 
of Percent of Time 

Students Enrolled As of Date –
This file is from the close of FY20 
Beginning of the Year Student 
Collection

District Relationship –
1- Educating 
2- Services, no Instruction
3- No Services or Instruction



Filter on District Relationship 1
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Filter on District 
Relationship 1

See headcounts and 
counts by percent of 
time, by district, 
building, and grade 
level for students your
LEA is educating



Additional Summary Data 
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After clearing filters,
scroll down the report 
and see summary data 
by building and district 
by Received Reason and
Sent Reason 1

This summary information can be 
helpful, however if this data is in 
question, it would be necessary 
to refer the detail version of this 
report

It is important to note that a student 
will be counted in the Received Reason 
Section and the Sent to 1 Section 



Adding Borders 
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This can be excellent, up-to-date 
data to send to others in your district
• Data as of Source Data/Prepare date
• May need to translate EMIS coding

using the Student Standing (FS) 
section of the EMIS Manual

From the Home tab, 
add borders to make 
the report more user 
friendly

Select all data by placing 
cursor in cell A1, hold 
down Shift and Ctrl 
keys and then hit right
arrow then down arrow



Quick Check • Are you processing updated SIS data in 
the Data Collector on a regular basis? 

• Are you able to format and filter the 
Enrollment Headcount Summary 
Report? 

• Who in your district might benefit from 
seeing this data on a regular basis? 

The Enrollment Headcount 
Summary Report can provide 
up-to-date enrollment 
numbers quickly. Enrollment 
numbers are available as 
headcounts and percent of 
time. Data is also broken out 
by Received Reason and Sent 
to 1 Reason. 
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Enrollment Headcount 
Detail Report
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Enrollment Headcount Detail (Current Students)
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• Provides a quick and comprehensive set of data 
• Contains elements from multiple record types

• Contains only data from your LEA’s SIS 

• Contains data as of a specific date (date of the data/prepare)

• Based on enrollment as of “today” so running a prepare after the school 
year ends could give skewed results 

• Available in closed collections such as Beginning of Year and Midyear for 
“snapshots” of data based on the last prepare (Mid-December/End of 
April)

• Consider saving this report regularly as it will be overwritten with each 
prepare



Create your own Summary Data 
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Open the Enrollment
Headcount Detail Report 
(Current Students)



Prepare the Report 

• Open Enrollment_Headcount_Detail_Report_(Current_Students)
• Wrap text header row

• Freeze top row

• Expand all columns

• Apply filters

• Better yet, run your macro!

• To learn how to record a macro, prior year EMIS Alliance Excel sessions 
can be found here 
• https://community.mcoecn.org/display/EM/EMIS+Alliance+Public+Space
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Report Contents
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District IRN
Building IRN
Student’s Enrolled 
as of Date

Student Standing (FS)
Legal District of Residence
How Received Reason 
How Received IRN
District Relationship
Percent of Time 
Sent To Reason (1&2)
Sent To IRN  (1&2)
Sent to Percent of Time (1&2) 
Admission Date
Effective Start Date
Effective End Data (Blank)
Withdrawal Reason (Blank)

Student Attributes – Date (FD)
State Equivalent Grade Level
Disability Condition
Disadvantagement
Limited English Proficiency

Student Demographic (GI)
Last Name 
First Name 
Gender
Summative Race 
EMIS ID
SSID 

This report contains a unique set 
of EMIS elements that is created 
each time data is prepared. If 
source data is timely, this report 
could reflect data as of today



Why Pivot Tables? 

• Pivot Tables 
• Create a quick summary view of a detailed report 

• No formulas needed 

• Make changes on the fly 

• Drill down to the details 

• Great way to present data to others in the district

• Will get easier to setup the more you use them 
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Create a PivotTable
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From the “Insert” tab 
select “PivotTable” 

Leave the “Create PivotTable” 
prompt as defaulted and select OK



New Tab and Next Step
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We are now on a new 
tab in the workbook

The next step is to decide 
what we want to include 
in our PivotTable and how 
we want it to look  

This section contains 
the column headers 
from your spreadsheet  



PivotTable Boxes
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Moving one or more column 
headers into this box will 
create a filter(s) above your 
PivotTable

Moving one or more column 
headers into this box will 
create a row or rows on the 
left side of your PivotTable 
using the values from the 
columns on your spreadsheet

Moving one or more column 
headers into this box will create 
columns across the top of your 
PivotTable using the values from 
those columns on your spreadsheet

Column headers placed in this box 
will represent the values that 
appear in the body of the PivotTable. 
Values can be summed, averaged, 
counted, etc. 



Grade Level by Building
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Watch the PivotTable take shape as fields 
are added to the PivotTable blocks

Click and drag fields into 
the PivotTable boxes 



Grade Level by Building, cont’d
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Update headers names to make the PivotTable more user friendly

Select columns C thorough O and drag 
to widen them equally, all at the same time



Add Gridlines
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1. Place cursor in cell A3, then hover over 
cell A3, until you see a black arrow, then 
click in cell A3. This will select the PivotTable 
cells. Add borders to the PivotTable.

2. Select the Borders icon, and “All Borders” 



Filter on District Relationship
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Check the box to be able to select filters 

Filtering on District Relationship 1 will give a 
clearer picture of students attending your LEA



District Relationship 1 - Educating
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This PivotTable now shows attending students by building and 
grade level as of the date of the Data Source data and Prepare 

Double click into a cell on the PivotTable to view 
the students who are included in the count 



View Students in a New Tab
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A new tab will open containing 
the data from the cell

Leave the tab and go back to your PivotTable
on Sheet1, or right click on Sheet2 and Delete



Create Another PivotTable
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1. Toggle back to the Enrollment 
Headcount Detail Report 

2. From the Insert tab select PivotTable 

3. Leave the “Create
PivotTable” prompt 
as defaulted and 
click “OK”



Disadvantagement by Building
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Set up and 
format 
PivotTable



Grade Level by Building and Gender 
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Set up and 
format 
PivotTable



Insert Slicer Instead of Filter 
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1. Create the PivotTable with 
nothing in the Filter box

2. From the PivotTable Analyze 
Tab, select Insert Slicer 

3. Select “District 
Relationship”



Slicer on District Relationship
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Much like a filter, a slicer allows 
the data to be shown based on
a selected value 

Right click on the Slicer 
to see additional 
settings such as a multi-
select option 



Quick Check • Are you processing updated SIS data in 
the Data Collector on a regular basis? 

• Are you able to format and filter the 
Enrollment Headcount Detail Report? 

• Are you able to create PivotTables from 
the Enrollment Headcount Detail 
Report? 

PivotTables create a quick and 
easy summary of data that 
can be very useful in 
troubleshooting data. 
Summary data is also very 
helpful to others in your 
district who monitor 
enrollment and attributes of 
students. 
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FTE Detail Report PivotTable
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FTE Detail Report

FTE Detail Report Contains 
• Funding data for students 

• Your LEA’s data and data from other LEAs

• Could have more than one line per student

• Each row is calculated with a base FTE 
• Each row contains a unique set of funding elements

• Gets larger as the school year progresses 

• Is generated nightly by ODE with data received as of 5pm
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FTE Detail Report
Begin by opening an FTE Detail Report 

• Student Collection – Level 2
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No need to prepare the report 
Before creating a PivotTable



FTE Detail Report PivotTable
Create a PivotTable in an FTE Detail Report

40

From the Insert Tab 
select “PivotTable”

On the Create PivotTable 
Prompt, select “OK”



PivotTable Fields
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When inserting a PivotTable 
using the defaulted options, 
a new worksheet tab is opened

We will select PivotTable Fields next



Select PivotTable Fields
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1. Click and drag fields 
into the PivotTable 
areas below 3. Then select 

“Sum” and “OK”

2. If Values do not appear as 
“Sum of” select the dropdown 
arrow, then “Value Field 
Settings”



PivotTable
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Click on specific values to 
drill into the detailed data 

Refer to the FTE Detail Report Explanation
For definitions of Fund Pattern Codes 

Inclusions codes typically indicate where 
funding is initially going 
• FULL and PART indicate that your LEA

is initially receiving funding 
• NONE indicates that the funding is

initially going to another LEA



FTE Report Explanation – FTE Fund Patterns
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This is a small section of the FTE Fund 
Pattern Code section of the report
explanation

Use this information to learn what attending 
situations your LEA has and if the funding is 
flowing as expected



Pivot Table Filter 
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Filter on Row Labels and select just the 
Fund Pattern Codes you would like to see, 
then click “OK”

In this  example only ATSM, JPSN, 
and SPCO were selected in the filter



Quick Check • Are you able to create a PivotTable and 
drill into the detailed data?

• What other fields in the FTE Report 
could be brought into a PivotTable?

• Can you think of other reports that 
could be analyzed using PivotTables?

PivotTables can provide a 
summary of a large amount of 
data that allows the data to 
be analyzed in smaller 
sections.  Try using 
Recommended PivotTables to 
view different ways to analyze 
your data. 
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Summary

• Basic Excel techniques can be very useful when 
troubleshooting
• EMIS data in the Student Information System

• EMIS reports

• These techniques should be part of your everyday 
practices
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Resources

• Access previous EMIS Alliance sessions 
• https://community.mcoecn.org/display/EM/EMIS+Alliance+Public

+Space

• Microsoft Excel Help within Excel “?” Articles and Videos

• Google it 

• Microsoft Excel Classes

• Your ITC
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Questions?


